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PART 1

GETTING
STARTED WITH
AFFINITY
PHOTO

Affinity Photo

Kirk Schwarz takes an in-depth look at Affinity
Photo, an award-winning photo editing suite that
offers powerful features at an unbeatable price.

ONE-TIME
PAYMENT

M Affinity Photo is yours for
the one-off cost of £48.99, or
only £19.99 for the iPad app
M Visit affinity.serif.com/
photo

n N THE WORLD OF Affinity, truly meaning the catalogue of Adobe work identical experience to the

image editing, plenty  only limit to your creativity when you switch over. desktop version.

of software packages claim to is your imagination. With such impressive

offer the ultimate experience. As well as allowing you specs, it’s little wonder that What you can expect

But none of these have excited  access to such essentials as Affinity has claimed both our ~ We’ll be running through

us as much as Serif’s Affinity Layers and Masks, you also own five-star Highly Rated all aspects of photo editing,

Photo editing suite. have excellent Live Filters, and Best in Test awards on starting out in this issue

This fully-featured editing ~ which allow you to see the every appearance, as well as with a look at the Develop

software manages to create effects as you apply them — an Apple award for App of Persona, where we’ll show

a perfect balance between a must for the perfectionist the Year 2017. you how to get the best out

familiarity and innovation in us all. It also offers a huge Therefore, throughout this  of your RAW files.

thanks to its use of industry degree of customisation, special supplement, we’re We'll also be looking at

standard tools, as well as an non-destructive adjustments going to explore the key Affinity’s ability to create

ethos of creative freedom. and the amazing ability to aspects of this amazing stunning landscapes,

Few packages share such work with PSD files, meaning  software, taking an in-depth thanks to the Tone Mapping

an incredible feature list as you won’t lose your back look at exactly what Affinity Persona, as well as how to
Photo canreally do, including  make the most of the brilliant
a peek at the amazing iPad portrait features, which

¢ AFF| N |TY HAS C LAl M ED O U R version, which is hands down  includes one-click frequency
\/ E RY OW N CO\/ ETE D I:|\/E_ the best fully featured mobile  separation, taking all of the

image editing software hard work and effort out of

STAR B EST | N TEST A\/\/AR D ” available, offering a near- this advanced technique.

LANDSCAPES MAKE YOUR
WORK SHINE IN ONE CLICK
Affinity has a number of
powerful tools for landscape
photographers, including a
dedicated Tone Map Persona.
Opening your images in this
Persona allows you to merge
a series of photos together to
create an HDR image, which
you can fine-tune with a series
of dedicated sliders.

BEFORE

L

GETTING STARTED // AFFINITY PHOTO

FOUR THINGS
THAT WE LOVE
ABOUT AFFINITY

Here are the features which we
think make Affinity the best new
editing software on the market.

LIVE FILTERS

I‘E' If you’re the creative type

- who always adds Radial
Blurs or likes to Liquify, you’ll love
the ability to see your effects in
real-time. This aspect really takes
the guesswork out of complicated
edits, meaning everybody has the
power to create stunning results.

TONE MAPPING

.{:‘! HDR is an area which

- many still consider a
complicated process. However,
thanks to the dedicated Persona,
merging multiple shots couldn’t
be more simple. It offers a series
of one-click presets, as well as
sliders to create the perfect shot.

FULL CUSTOMISATION
f"ﬁ- Affinity is set up in such
il
a way that nearly all
aspects can be customised to
your liking. Through a simple
process, you can add tools and
tabs, ensuring that your favourites
are always close to hand, and best
BEFORE suited to your needs.
AFFINITY FOR IPAD
f‘:& Not content with creating
- an amazing desktop
experience, Affinity is also
responsible for the best image
editing app on any mobile device.
It’s so good, you can follow along
with these tutorials without
leaving the sofa.

PORTRAITS EASILY CREATE
HIGH-END RESULTS

When it comes to editing
portraits, the more advanced
skin retouching techniques
used to be a difficult trick to
master. Luckily, Affinity makes
everything so simple, even
including a one-click Frequency
Separation mode.
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A quick look
iInto the power
of Personas

FFINITY PHOTO

has been designed
from the ground up to offer
an unbeatably smooth and
intuitive experience. It’s
powerful enough to impress
any professional looking for
a fully-functioning editing
suite, while also allowing
first-time users to create
fantastic results. It achieves
this by dividing tasks into
Personas. These tabs house
various editing setups, and do
an excellent job of keeping
your workflow intuitive.

With just a single click,

you have access to a wealth of
abilities, including powerful
Tone Mapping to create HDR
images, the most intuitive
Liquify tool available and an
excellent RAW conversion
experience. When you start

LIQUIFY PERSONA
RESHAPE YOUR SHOTS
WITH THIS AMAZING TOOL
Liquify is an impressive
image reshaping feature,
including tools such as Push
Forward, Pinch and Punch.
However, Affinity takes it one

step further by showing the effects

using these alongside the raft
of industry standard tools
and adjustments on offer,
you’ll see why Affinity Photo
has been winning awards and
earning widespread acclaim
since its initial release.

Personas explained
Here, we’ll be taking a quick
look at what each Persona is
capable of, offering you a brief
overview and pointing out
some of our favourite key
features, many of which may
be surprisingly familiar to
you. Over the course of this
complete guide, we’ll also be
going in-depth to show you
some simple ways to achieve
excellent results, covering
genres from landscapes to
portraits, and everything
in-between.

in real-time, including any underlying

Layers, as well as adding a customisable grid, allowing
for precise control, and a Reconstruct Mesh, which can
automatically lessen the effect by any degree — amazing.

ADAM BURTON

NEVER BLAME
YOUR TOOLS
Everything you
need to edit your
photos is right

at your fingertips
in this handy

toolbar. You can

even customise
it to make sure

you have quick
access to your
favourite tools.

DEVELOP PERSONA
A POWERFUL RAW
CONVERSION MODULE

RAW conversion is an

essential, and Affinity’s

Develop Persona is

outstanding, allowing you full
control over fundamentals such
as Exposure, Contrast and White
Balance. You also have an advanced

lens distortion correction tab, as well as the excellent Before
and After tools, which allow you to make sure you’re happy with
changes before you jump to the other Personas to finish the job.

The large canvas area ma
simple to keep your eyes on your
work, with Affinity blending
seamlessly into the background.

TONE MAPPING PERSONA
CREATE BREATH-TAKING
HDRS IN MERE SECONDS

Tone Mapping maximises a
shot’s dynamic range, which it
achieves by merging data from
multiple bracketed images.
However, Affinity’s Tone Mapping
Persona works just as well with a
single image, giving you instant results.

You have access to a large library of one-click effects, including
the excellent James Ritson custom creations, and a wide array
of sliders allow you to craft the effect that best suits your vision.

GETTING STARTED // AFFINITY PHOTO

PHOTO PERSONA

HOME TO TOOLS, LAYERS
AND ADJUSTMENTS

Packed with industry standard
tools, adjustments and creative
filters, the Photo Persona is
where the majority of your
editing will take place. Whether
it’s working on your colours,
adding selective Dodging

and Burning or even creating
sprawling complex photo
composites, this is where

the magic happens.

SO MANY OPTIONS

Affinity houses a wide range of
features to aid in your editing.
Everything from an infinite
History slider to a powerful
integrated stock photography
panel is waiting for you to take
full advantage of.

ADJUSTMENTS GALORE
With so many Adjustment
Layers available, non-
destructive editing gives you
the freedom to edit without
fear of ruining your shots.

8 MULTIPLE LAYERS
i EE E Affinity supports Layers, which
means you can create complex
composite images, really letting
your imagination run wild.

EXPORT PERSONA
HAVE PRECISE CONTROL
WHEN SAVING YOUR WORK
While you can easily save your
work without utilising the

might of the Export Persona,
those who have the same

exacting standards as us will be
delighted at the power this module
offers. Allowing full control over saving

your images makes sure the world sees them as you intended.
Affinity Photo even lets you save as PSD files, meaning working
with cross-platform clients becomes incredibly simple.
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LANDSCAPES // AFFINITY PHOTO

PART2 VS

ENHANCING
AMAZING
LANDSCAPES

WHY AFFINITY IS
PERFECT FOR
LANDSCAPES

Affinity is a fully-featured editing
package, which offers you all
the top-end professional tools,
allowing you to create truly
stunning results.

DEVELOP PERSONA
BEFORE f‘!‘_" No landscape editing

would be complete
without the ability to tweak your
RAW files. The Develop Persona
gives you the flexibility to recover
highlights, create selective edits
and perfect your colours.

ALL THE TOOLS
f“j-. Affinity’s strength comes
fe— . . .
in its variety. Instead of
hand-holding, it allows you true
creative freedom, meaning you
can create the edit you have in
your mind, without having to
worry about constraints.

EDIT AS YOU SHOOT
LANDSCAPES REVEAL THE HIDDEN DETAIL IN YOUR SHOTS ,{E e oirlllEwiIFEe) £

Affinity Photo has a tool or adjustment for every occasion. These offers everything the

include Dodge, Burn and Curves - ideal to add the perfect contrast. desktop version does, including
RAW editing. This means you can

transfer your shots to your iPad as
you shoot, and have them edited
before you even get in the car.

S103r04dd TIAVHL IAILYIED

Kirk Schwarz walks you through getting the most
out of your landscape photos using Affinity’s RAW
editor and the powerful Tone Mapping Persona.

m ITH SO MANY
stunning landscapes

around us, ripe for capture,
they’re a staple of our
photography portfolios.
Whether it’s sunrise, sunset
or just an interesting location
we’ve stumbled across, we're
never without our cameras.
Of course, even the best
shot in the world can benefit
from a touch of editing, and
that’s where the excellent
Affinity Photo comes into
play. On the previous pages,
we journeyed through the

five different Personas, taking
a brief look at what this
very powerful photo
editing software could offer.
Now we’re going much more
in-depth with a longer look at
the Tone Mapping Persona.
Using a RAW landscape
image, which we’ll show
you how to convert in the
Develop Persona first, we're
going to choose a custom
Tone Mapping preset from
the many on offer and walk
you through the huge range
of customisation options.

“THE JOY OF HAVING SO
MUCH CONTROL IS THAT T
MAKES A SHOT YOUR OWN”

The joy of having so much
control is that it really allows
you to make each shot your
own and actually gives you
the level of freedom to be as
subtle or as crazy as you want
in your final edit.

When you’ve finished in
the Tone Mapping Persona
and applied an HDR look to
your image, you’ll then be
placed back into the Photo
Persona, which means you
can carry on editing, using
tools such as the Clone Stamp
Tool to tidy up any little
imperfections, or even throw
in a couple of Adjustments,
meaning you can change the
Colour Balance, add some
Split Toning or even convert
your shot to black & white if

that’s the look you're after.
The choice is entirely yours.

Which photo?

We’re using a shot from Blyde
Canyon in South Africa, but
you are free to use any photo
you'd like, though the
technique will work best

if you make sure you have

a shot with plenty of contrast,
and with details captured in
both the shadows and the
highlights. This will ensure
the Tone Mapping has
enough data to work with as
it processes the initial image.
Of course, even though this is
alandscape masterclass,
you’re free to try it with any
of your shots, even wildlife

or portraits.

EDIT YOUR SHOTS ON THE MOVE THE AMAZING AFFINITY IPAD APP
When you’re out shooting landscapes and you want to get started with the editing process
straight away, the Affinity Photo app is a boon. It offers an identical level of functionality as
the desktop app, so you can even follow along with this tutorial on the go.

TONE MAPPING

iﬂ. PERSONA
- Giving you the ability to
create instantaneous HDR results

from multiple or single images,
the Tone Mapping Persona is as
simple as it is powerful. You even
have access to the brilliant James
Ritson custom profiles.

6 PRACTICAL PHOTOGRAPHY

PRACTICALPHOTOGRAPHY.COM 7
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TIP
RE-DEVELOP

This tutorial refers to RAW

conversion, but Affinity lets
you use the same tools on
your JPEGs. Simply click

AFTER

the Develop Persona
at any time.

Give yourself a head-start with
Affinity’s Develop Persona

m E ALL KNOW
that RAW files

capture a phenomenal
amount of data in comparison
to JPEGs. However, to make
the most of this data, you
need the software to read it

- which is where the Develop
Persona really shines.

In this first step you'll see
how to make the most out of
your RAW landscape image,
recovering highlights and
shadows, as well as adding
some vibrancy, perfecting the
colours and using gradient
tools to add selective edits.
This will allow you to make
skies look moody without
affecting your perfectly-
exposed foregrounds.

Once you've explored the
tools on offer and created
your very own magnum opus,
youwll be taking it into the
Tone Mapping Persona to add
the final touches and bring
out all the hidden details.

With Affinity Photo’s
ethos of creative freedom,
you are always able to jump
back into the Develop
Persona to touch up your
work if you’ve missed
something in the edit, as
well as moving seamlessly
between the Develop and
Photo Persona, which gives
you access to tools such as
the Clone Stamp Tool, Colour
Balance or the powerful
Dodge and Burn.

BEFORE

Above & top This RAW image doesn’t do the scene any justice.
With just a few tweaks, you can completely change your shot.

“AFFINITY PHOTO ALLOWS
YOU TO MOVE SEAMLESSLY
BETWEEN THE PERSONAS”

Get your exposure spot on
Open your Basic Tab and increase the Exposure and
Brightness sliders to lighten or darken the image, but

don’t blow your highlights. You can also increase your Blackpoint
to 5% to deepen the blacks, which really makes the shot pop.

Recover your shadows and highlights
a Click on Shadows & Highlights and slide Shadows right

to increase the brightness in the darker areas — we’ve
gone to 15%. Slide the Highlights slider left to recover details in
the brighter parts, preventing the sky from being too bright.

THREE TOOLS FOR

Uqﬂ

i

-

OVERLAY GRADIENT TOOL

OVERLAY PAINT TOOL

Add some contrast to make it pop
Set the Contrast and Clarity sliders to bring out the
details — to 12% and 10% respectively in our shot. If your

colour isn’t jumping out, you can increase Vibrance to bring out
rich tones — we’ve gone to 50% and the result is subtle.

Use a gradient to edit your sky
Click the Overlay Gradient Tool and select Linear. Now
drag from mid-sky to your horizon. The red mask is the

only area that editing will affect, so use the previous three steps
to perfect your sky. Click Develop when you’re finished.

PRECISION EDITING

OVERLAY ERASE TOOL

;"‘ This allows you to mask off ;"‘ Similar to the Gradient Tool, ;"‘ This handy erase tool allows

an area, meaning only your
chosen area will be affected by any

editing, perfect for bright skies. pin-point precision.

but this actually allows you to
create your mask with a brush tool for

you to remove any area of
your mask by simply brushing, which
is great for detailed fine-tuning.
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Use Tone Mapping
to create instant impact

C REATING HDR
photos can be an

in-depth and advanced
technique, often requiring
you to shoot a series of
exposure bracketed images
(meaning they’re shot at
different exposures). Affinity
Photo includes a dedicated

Tone Mapping Persona to
take on some of this work.
While this Persona does
allow you to import multiple
images and create your final
shot, it can also create the
effect using a single
exposure, which it will
automatically turn into a

Open the Tone Mapping Persona
Once you've finished the Develop process, you'll be sent
to the Photo Persona. This is great for getting in-depth,

but Affinity has an easier path to amazing results — simply click
the Tone Mapping Persona to carry on.

stunning HDR image at the
click of a button. The best
thing about this technique is
that you have a wide range of
one-click presets designed to
cover nearly every type of
shot you can envisage. You
can even see the results in
real-time. You also have the

In the Tone Mapping

BEFORE

Above & left We’ve turned our RAW
image into a great starting point, making
sure we have plenty of tones. In just five
steps, you can really ramp up the visual
impact of your shot.

TIP
EXPERIMENT

With such a wide range of
presets available, don’t be
afraid to experiment.
The menu even offers
Crazy and Extreme
options.

usual exposure, contrast and
colour tools, as well as Tonal
Compression, Local Contrast
and even an excellent
Overlay Paint Tool to create
a custom mask, allowing for
a truly mind-blowing level of
selective editing possibilities
for your landscape images.

Select your Preset

Persona, on the left you'll
see the presets. Open the drop-down

menu and click James Ritson Customs.
For this tutorial, we’ve used the ‘Lift Shadows,
Max Punch’ preset, though feel free to experiment.

Adjust your tonal compression
For this scene, the instant effect is a little too powerful.
Sliding the Tonal Compression slider left will reduce the

overall effect, while dragging the Local Contrast slider left will
decrease the clarity in the image, making it a touch more natural.

Edit the exposure to suit your scene

You’ll recognise the same tool layout as the Develop
Persona, which keeps this step simple. Drag the
Exposure, Blackpoint and Brightness sliders to fix your Exposure,
and use the Shadows & Highlights to bring back any lost details.

Fix the colours with a mask

Click the Overlay Paint Tool, and simply brush over
the saturated areas to create a mask. Now reduce the
Saturation and Vibrance sliders. If you’ve made a mistake, click
the Overlay Erase Tool to erase the mask. Now click Apply.

LANDSCAPES // AFFINITY PHOTO

IIKNOWHOW THREE OF THE
BEST ONE-CLICK EFFECTS

With so many on offer, we thought we’d give you a helping
hand by showing you our three favourite presets, ranging
from a calm and natural look, to something more extreme.

DRAMATIC
& Found under the
- Default tab, this
punchy preset gives you an
instant colour boost without
giving you too much clarity.
It’s ideal for bright images
with a wide range of
colours, and is perfectly
suited to bring out the best
details in your favourite
summery blue-sky shots.

MAXIMUM GRIT
& Found under the
' Extreme tab, this
preset is unashamedly HDR.
Packing in a huge amount of
Local Compression and an
increase in sharpening, it is
perfect for gritty black &
white portraits, especially
on those subjects who have
one or two wrinkles or
furrowed brows.

ARCTIC CHAMBER
This James Ritson Custom is ideal for enhancing

' those tones. Bringing the colour temperature
down and increasing the Local Contrast, it’s perfectly
suited for bringiong the most out of your foreground,
making it ideal for long-exposure winter waterfalls.
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PART 3

EXPLORING
MONO URBAN
ENVIRONMENTS

STANDARD CONTRAST

WHY AFFINITY IS
PERFECT FOR
B&W EDITING

Affinity’s brilliant non-destructive
adjustments allow a huge range of
creative freedom. These come into
their own when converting colour
to stunning black & white.

BLACK & WHITE
!‘ Starting with an obvious
""" one, the powerful Black
& White Adjustment allows you to
fine-tune each individual colour
with simple sliders. This lets you
make micro changes that are
otherwise near-impossible.

LEVELS AND CURVES
"‘ Affinity offers both,
fa— : :
allowing you to fine-tune
shadows and highlights to the nth
degree, which is perfect for those
eye-catching black & white
conversions with ultra-bright
whites and smooth blacks.

\

Affinity Photo

Kirk Schwarz shows you how to get the most from is perfect for taking control over
your abstract architecture and gritty black & white S— ;';if‘mg'r‘lgg:g:];’::f;:;:s'"
street photos in this easy to follow tutorial. = ;

GRADIENT MAP
USING LEVELS INSTANT BLACK & WHITE EXCELLENCE A our personal favourits,

Simply add a Levels Adjustment and increase the Black Level to 10% fa adding a Black & White
and decrease the White Level to 90% for an instant contrast pop. Gradient Mask allows you to

S3190T0NHO3L 3DVINI OONIDIHO

B | sragientmap

ITIES ARE GREAT buildings and purpose-built detail for your viewers to you can re-jig your edit as e ; o
for so many reasons.  steel monoliths provide the marvel at. Taking it one step much and as often as you : 2 b fﬁﬂ
Not only do they often have perfect playground for further, adding a Soft Proof like. To really harness the U,_',m i e T

the best shops and a vibrant adventurous architectural Adjustment will allow you to power of black & white, it’s
night-life, but they also offer photography enthusiasts. instantly create a beautiful important that you have a
incredible architecture and Of course, taking the shot washed-out look, adding an shot that translates well.
loads of creative potential. is only the first step on the extra depth to your tones The best mono photographs
Exploring busy shopping way to greatness. A small with a traditional film are often those which have
precincts and more secluded amount of natural editing appearance. You can also plenty of contrast, and a
back alleys will reveal a whole  can help to really uncover the  explore the Tone Mapping strong amount of dominant
host of intriguing characters,  hidden potential in even your =~ Persona, using HDR to ramp shadows and highlights. You
just begging to be framed up best work. Adding simple up your street portraits. can often find the right mix :
by your camera. edits, such as contrast and in shots taken in directional : " - ‘ : SOFT PROOFING

Gradiant Map

If you prefer your subjects  clarity, will give your shots Keep ultimate control light, early morning or late i | - !‘ "%\ Designed to represent
to be silent and static, the a gritty look, while managing  All of these techniques are afternoon, when the sun is g ; v different print spaces,
often eclectic mix of old stone  to emphasise every little non-destructive, so you can at its lowest point. P . " Soft Proof can also be used to

go back and fine-tune your Finding this perfect mix j < B . add an artistic effect. Cycling

individual Layers to ensure increases the depth, so try between options can give you a
“NATURAL EDITING CAN you have the perfect results.  and make this work to your EDIT IN YOUR LUNCH BREAK WITH THE AMAZING AFFINITY IPAD APP subtle washed-out look, which is
U N GO\/ER H | D D EN POTE NT|AL And don’t forget that Affinity ~ advantage by having one side We’ve previously explored the massive power of Affinity’s iPad app, and once again you ideal for adding a sense ?f filmic

will save these Layers, as well  in constant light, and the can use it to follow along with this entire tutorial. The best part is that you can take it depth to your black & whites.

| N E\/EN YQ U R B EST \/\/O R K i as your full History, meaning  other bathed in deep shadows. anywhere, so grab a sandwich and sit down to create your mono masterpieces.
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Learn how to add a gritty
feel to your street photos

BEFORE

Above & left Adding a black & white
conversion, as well as increasing noise
and clarity, has given us a completely
different feel to our starting image, really
helping to bring this character to life.

TP
EXPERIMENT
WITH GRADIENTS

The Gradient Map allows
you to add multiple points.
Experiment with different
tones for great
results.

u S FAR AS GENRES
go, there are few as

classic and inspirational as
street photography, harking
back to the days of pioneers
such as legendary Magnum
co-founder Henri Cartier-
Bresson and Vivian Maier,

who tragically only achieved

recognition posthumously.
Whatever your inspiration,
the subtle art of capturing
candid moments has moved
on relatively little since the
days of film, and nowhere is
this more obvious than the
wide-spread use of black &
white in modern street shots.

Of course, packing in a
massive amount of flexibility,
Affinity gives you more than
one way to create stunning
black & whites, and the
powerful Filters, such as
Noise, will allow you to add
a hint of vintage grain to
your work, really adding to

that gritty look. The great
thing about Affinity is that
we can do this entire process
non-destructively. Simply
put, this means your original
image remains 100% intact,
allowing you to alter any of
your changes at any point
throughout your edit.

Create a black & white Gradient Map
Open the Adjustment Panel and choose Gradient Map.
Click the left-hand circle, which will be red, click colour

and select black. Do the same for the right circle, changing blue
to white, and then the middle circle, choosing a mid-grey tone.

Adjust contrast
Double-click halfway between
the left and middle circles to

add a new point and choose a very dark
grey. You can slide this to change your
shadow strength. Repeat on the right-hand
side, choosing a very light grey.

Opacity: > Blend Mode: Normal

Increase your global Clarity

a Click your Background Layer and Duplicate it with
Ctrl+dJ. Open the Live Filters menu - the hourglass icon

below your Layers Panel — and select Clarity Filter. Add a radius

of 5-10px for local contrast to bring out your subject’s character.

Intansity

Gausslan

¥ Mo atlc

Opaclty: 100 % Blend Mode: Normal

Add a touch of noise for that film look
Again in the Live Filters menu, click Add Noise Filter.
Make sure you’re set to Gaussian and not Uniform, and

also have Monochromatic ticked. Set intensity to 15% to add
grain. Right click and select Merge Visible to create a Pixel Layer.

Add a subtle
hint of HDR
Open the new Layer

in Tone Mapping Persona.
Select Maximum Grit from the
Extreme presets tab. Set Tone
Compression to 25%, Local
Contrast to 15% and increase
your Blackpoint. Click Apply and
adjust Opacity to suit your shot.

URBAN MONO // AFFINITY PHOTO

IIKNOWHOW THREE WAYS
1O GO BLACK & WHITE

Black & white is a harsh mistress. Going mono is never as
simple as desaturating an image, which is where Affinity’s
range of powerful tools come in super handy.

GRADIENT
A%
, You set
custom colour
values to shadows,
midtones and
highlights, such as
black, grey and
white, to create your
mono. However, you
can add additional shades and alter their placement to
affect the image in real-time, which is perfect for bringing
your precise vision to life.

BLACK
& WHITE
By

simply clicking on
this Adjustment,
Black & White
instantly gives
you a flat
monochromatic
image. However,
using the
assigned colour
sliders allows

you the freedom
to alter the
underlying
colours, which is perfect for selective editing, especially
when you have a busy scene.

HSL
& Simply setting your Saturation slider to -100%
. is a very quick way to create a flat black & white
image. However, changing Master to Red, Yellow or one
of the other colours and increasing your saturation to

+100% can give you some interesting, yet easy to create,
selective colouring.
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PART 4 VLR

THE ART OF ' \
SHOOTING STARS TR

Kirk Schwarz delves into the vast mystery of space
with these two techniques to help you get the most
out of your amazing astro and star trail shots.

a TARS - POSSIBLY
the greatest

inspiration the human race
has ever known. Whether
you gaze up in amazement
on a dark, clear night, or you
purposely study the outer
reaches of our galaxy with a
powerful telescope, chances
are you’re blown away by
what you see. Of course, the
beauty of astrophotography
is that what you see is only
an infinitely small portion of
what’s to be found, and your
camera can help to uncover

of the unseen information,
as well as correcting the
colour and adding those
finishing touches.

these mysteries. Shooting
long exposures allows far
more light to hit the sensor
than the human eye can
perceive, revealing a myriad
of amazing details.

With a little bit of luck,
a tripod and some jiggery
pokery with your settings,
you can easily wind up with
a stunning dark sky-scape.
However, taking the photo
is only the first step in the
process, and the real magic
happens in post-processing,
where you can bring out all

What the pros use
The image above was shot
and edited by leading
astrophotographer - and
keen Affinity user - Zdenek
Bardon. The talented Czech
photographer has edited
countless shots in Affinity,
and has even had some of the
resulting shots published
by NASA, which must
surely count as one of the
highest commendations
either Affinity or Zdenek
could receive.

With such a wide range
of industry-leading tools, as

“THE REAL MAGIC HAPPENS
IN POST-PROCESSING, WHERE
YOU ADD FINISHING TOUCHES”

16 PRACTICAL PHOTOGRAPHY
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WHY AFFINITY
IS PERFECT
FOR ASTRO

Offering the ultimate freedom
allows you to craft your star shots
from the ground up, perfect for
revealing hidden details.

CLARITY
~% This handy filter
=

increases the local
contrast, which can often be
incredibly overpowering. However,
in small doses, you’ll find your
stars really pop against the
blackness of the sky.

BEFORE

BLENDING MODES
f‘ % One of the most
""" underutilised features
of image editing, Blending Modes
allow you to alter the behaviour of
a Layer in relation to the Layers
below, which makes adding colour
pops amazingly simple.

' DEVELOP PERSONA
BLENDING MODES SCREEN VS SOFT LIGHT g e DTN G

information hiding in
Screen hides the darkness in the Layer, where as Soft Light lightens : I aing |

lain sight, the ability to convert a
anything over 50% grey, and darkens anything that’s darker. ‘F)!A:N fill?a is essentli;I)./The De\\llelop

Persona’s powerful tools will allow
you to increase the brightness
of the stars, while retaining the
darkness of your sky.

NOQ4vd ¥INIaz

NYQHOd Mvd08

well as a can-do attitude
and creative freedom,
Affinity revels in creating
the impossible. It even
features an amazing
Exposure Merging function,
which, as you’ll see, allows
you to create star trails, such
as Zdenek’s, in a single click.
This is something that was
previously a laborious task,
having to change Blending
Modes on multiple Layers
one at a time.

Don’t just take our word
for it — get out there and
shoot your own astro images,
and once you’ve captured
a RAW masterpiece, come
back and follow our step-by-
step tutorial to really make
them shine.

Exposure Merging
Exposure Merging can
be used on Image
Stacks to take an average
metering of the individual Layers
and create the perfect exposure.
This is ideal for star trails, but also
very handy for anyone shooting
bracketed landscape shots.

L

Ll

CREATE YOUR OWN EPIC ASTRO SHOTS WITH THE AMAZING AFFINITY IPAD APP

Affinity Photo’s award-winning software is also available as an iPad app, and is perfect
for editing on the move. If you want to work on your astro images while still under the night
sky, the app is a perfect companion to check you’ve nailed the shot.

PRACTICALPHOTOGRAPHY.COM 17
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BEFORE

a10N NYa

Above & left In just two steps, you can import all of
your individual shots and merge them together to
create the final star trail image.

for us, you can also try

Use Blending Modes to | o
create amazing star trails \_"

AFTER TIP
EXPOSURE

MERGING

While Maximum works well

TAR TRAILS ARE incredibly simple to shoot, The individual shots will document as a series of

one of the most and even easier to create in have a slight trail to them, Layers. You’ll also be
creative avenues of Affinity Photo. but with a little Affinity exploring the Exposure
astrophotography, blurring To craft your shots, magic, you can blend them Merging function, which
the lines between fact and you’ll need to set your all together seamlessly to allows you to get the best
fiction to create a shot with shutter speed to at least create one mega star trail. exposure from multiple
a massive amount of visual 30 seconds, and take a series You’ll learn how to use shots with a single click.

impact. The great news
is that they are actually

of continuous shots over the Layer Stacks, bringing It’s so simple, you’ll have
course of 20 to 30 minutes. multiple photos into a single a masterpiece in minutes.

Har 49

Use Exposure Merge
a Now you’ll have a Group
Import as a New Stack called Live Stack. To merge
To open all of your star shots as a single multi-Layered your star trails, simply click the
document, go to File>New Stack. Click Add on the Exposure Merge icon to the right of the
dialogue box and select your shots. Click Open, then Click OK stack Layer and change to Maximum.

to add them to your Layers panel - this will take a minute. This will instantly create epic star trails.

45K 1o Belu.

Merge Down

Merge Visible

Merge your Layers to add finishing touches
a Once you've created your amazing star trails, click on

the Live Stack Group, the top Layer, and make sure it’s
active. Right click and select Merge Visible. This will create a new
Pixel Layer above the group, which you can edit further.

Perfect your contrast with Curves
Create a Curves Adjustment Layer. Now lower the left
side of the Tone Curve to darken the shadows, and raise

the right side to boost the highlights. Don’t worry if details get
blown out, we will fix that in the next step.

Mask off the
a unwanted areas

Click the Brush Tool and
set the colour to black. Now brush
any area where you don’t want the curves to be visible, and the
Layer Mask will hide them. To bring any area back, simply repeat,
but change your foreground colour to white.

ASTRO // AFFINITY PHOTO

/I KNOWHOW THREE WAYS
TO USE BLENDING MODES

Blending modes change the way individual Layers interact
with each other. This can create some unique results, and
these three are must-haves in your editing arsenal.

SOFT LIGHT
& The Soft Light
. Blending Mode
changes the values of the
current Layer based on

its relation to 50% grey.
Anything which is lighter
becomes brighter, and
anything which is less bright
becomes darker. It’s great
for adding subtle contrast
to your image.

W

SCREEN
& Screen is an essential Blending Mode, and one
' you simply must know for creating composites.
It makes blacks turn invisible, which is incredibly useful

if you have an image with a subject you want to use, and

a black background, such as fireworks or stars.

EXCLUSION
Add a new Layer and use the Paint Bucket tool

. to fill the Layer with a navy blue. Now set the
Blending Mode to Exclusion and you’ll notice the shadows
are blue, and the highlights are yellow. Reduce the Opacity
to 5% for a quick and easy cross-processing effect.

18 PRACTICAL PHOTOGRAPHY
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PART 5

MASTERING
PERFECT
PORTRAITS

HE CONSTANT
throughout all the

seasons is stunning light, and
we can take full advantage of
this when shooting portraits
whatever the time of year.
We’ve themed our shoot with
autumn in mind, but there’s
inspiration to be found in
every season.

While the later autumn
months may be dominated by
a magical show of changing
colours and falling foliage,
the earlier months change
very little. We’ll show you

Affinity

Create poweful portraits

Kirk Schwarz shows you how to use Affinity Photo
to get professional looking skin, as well as adding
an autumnal twist with a very simple colour edit.

how to use this to your full
advantage by shooting in
that fragile in-between time,
when the leaves are firmly
attached and the rich hues
haven’t quite started to make
their appearance yet.

To achieve this warm and
welcoming look, we’re going
to use some of Affinity

Photo’s powerful colour tools.

This will allow us to subtly
change the colour palette to
suit our scene. We’ll also
show you how to use the
brilliant one-click frequency

“THIS MONTH WE'RE USING
THE TONE MAPPING PERSONA
FOR STUNNING RESULTS”

separation filter. This makes
professional skin retouching
an absolute doddle, allowing
you to create outstanding
results, which would be a lot
more difficult to achieve in
many other editing packages.

What will you need?
All you need to create your
own autumnal wonderland is
anice portrait taken in an area
with plenty of lush foliage.
Don’t delay, as the seasons
tend to disappear before our
very eyes. When composing,
yow’ll want your subject to be
perfectly in focus, as well as
pretty large in the frame.
This ensures the frequency
separation will have the
maximum impact when

hoto

you’re separating the texture
from the colours, which gives
it that polished look.

To get the most out of this
effect, you’ll want to use a
shot with plenty of clean and
contrasting colours, since
you'll be targeting specific
hues to create your own
colour scheme. If you have a
model in a forest, make sure
their face isn’t picking up the
green hue which is often
reflected from the trees or
grass. Once you've selected
your perfect shot, simply
follow the next steps and
youw’ll not only master the art
of powerful and advanced
skin retouching, but you’ll
also be an ace when it comes
to colour grading.

Sk

PORTRAITS NOT SURE? ASK AFFINITY TO HAVE A GO

Go to Filter>Colours>Auto Levels and watch in amazement as Affinity
decides what level of contrast and toning best suits your image.

FOLLOW ALONG WHEREVER YOU ARE WITH THE POWERFUL AFFINITY IPAD APP
The Affinity Photo iPad app is great for the busy portrait photographer. Thanks to its
fully-featured approach, offering an identical level of functionality as the desktop app,
you can even follow along to this whole tutorial.

PORTRAITS // AFFINITY PHOTO

WHY AFFINITY
IS PERFECT
FOR PORTRAITS

Affinity Photo includes industry
leading tools, but manages to
improve on them, especially in the
case of blemish removal and skin
retouching — a must for portraits.

FREQUENCY
!‘&_ SEPARATION
™ The ability to create a

complicated frequency separation
with a single click is amazing,
allowing you to master this very
powerful skin retouching
technique from day one.

HEAL ALL ILLS
"‘_ Affinity features a full
A= ,
complement of skin
retouching tools, including a
Healing Brush and Blemish
Removal Tool. Using these, you
can quickly and easily tidy up
any little imperfections.

AFFINITY KNOWS
!‘?‘_ If you’re new to editing,
™" Affinity Photo offers

automatic tools. The Filters menu
houses Auto Colours, Contrast
and Levels, all of which are ideal
to give you an instant boost and
lead you in the right direction.

COLOUR THE WAY
!"‘_ YOU WANT IT
""" Colour is one of the most
important tools you have at your
disposal, and Affinity Photo has
a great selection. Whether Colour
Balance, Selective Colour or even
the powerful Channel Mixer, you
have all the tools you’ll ever need.

Colour Balance allows you
to create dramatic colour grading.

20 PRACTICAL PHOTOGRAPHY
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Haaling Brush Tood

Pateh Tool
Blamish Removal Tool
Inpainting Brush Tool

Ried Eye Removal Tool

TIP
BRUSH IT IN

If there isn’t enough clear
skin to clone from, select
the Brush Tool and set the
Opacity to 15%. Holding
Alt lets you pick a
close colour.

-

AFTER . \\4

Create easy frequency
separation in just one click

Create a Frequency Separation
Go to Filters>Frequency Separation. Slide the Radius
until the texture on the colour half of the image has just

become too blurred to make out. Click Apply and it will create two
Layers. High Frequency is your texture, and Low is your colour.

Remove the blemishes and imperfections

a Click the High Frequency in the Layers Panel. Now
choose the Blemish Removal Tool and click on a
blemish. While holding down your mouse button, move the cursor
to an area of clean skin and let go. Repeat until you’re happy.

m AVE YOU EVER pro photographer’s editing LHE L0 TEQBFNCY SERATAION Use the Clone Stamp Tool to even tones Use Gaussian Blur to smooth the skin
picked up one of arsenal. It splits your image i 3 a Click on the Low Frequency Layer and choose the Clone n Choose the Free Hand Selection Tool and set Feather
those ultra-glossy magazines into two entirely different Stamp Tool. Set Opacity to 20% and while holding Alt, to 40px. Draw around any area where the texture needs
and seen models whose Layers. The first is a blurred click a source point. Now brush in over any area where the skin smoothing. Go to Filters>Blur>Gaussian Blur and set a Radius
perfectly flawless skin looks Layer, which controls your tone looks unnatural. This is great for bringing back highlights. that smooths the skin, but be subtle — 7.2px worked here.

too good to be true? Then it colour, and the second is a
probably is! Even top models texture Layer, which is set
don’t turn up to the studio to a Linear Light Blending
looking that great. It’s a Mode. This allows you to
combination of make-up work on your skin tones and
artistry and some savvy skin texture individually.
post-processing. While we That may sound overly
can’t recommend make-up complicated, but Affinity

artists enough, they’re
probably overkill if all you're
doing is taking some nice
shots of your friend. This just
leaves the retouching option.
Frequency separation is
one of the most popular, and
successful techniques in any

Photo’s Frequency Separation
is automated. That’s right,
with a single click, Affinity
creates your split Layers

as required, while also
allowing you to fine-tune
each individual aspect for the
best possible looking results.

“AFFINITY PHOTO MAKES
COMPLEX RETOUCHING

THREE STEPS TO INNER HEALING

&
Healing Brush Tool

Fateh Tool

Blemish Removal Tool

Inpainting Brush Toaol

Red Eye Remaval Tool

HEALING BRUSH TOOL

f‘ % This allows you to set your own source point, like
the Clone Stamp, but automatically blends in

based on the surroundings - ideal for texture work.

BLEMISH BRUSH TOOL
~% This tool allows you to click on any area, and drag
Ja—
to a new area where you prefer the texture. It then
blends it in seamlessly by calculating the texture and
colour in the area around your selection.

INPAINTING TOOL
f‘ U This brilliant tool lets you paint over an area, and
= Affinity will work out what to fill it with, based on
the surrounding areas. This makes it ideal for removing

Above The heat and direct light makes the skin look a little blown
out. In four steps, the skin looks smooth and natural.

unwanted distractions from your scenes.

INCREDIBLY SIMPLE”
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OLOURS ARE AN
intrinsic part of our

daily lives, and they dominate
our world. In photography,
they are one of the most
important tools you have to
connect with your viewers.
However, cameras don’t
always capture the vista as

we see it. RAW files retain
basic data about the scene,
but it’s up to you to bring that
information out as you want
to show it. Similarly, JPEGS,
which don’t capture the
same level of detail, look a lot
more vibrant out of camera.
However, a JPEG is an image

Warm the colour balance
Open the Adjustments tab and choose White Balance.
Sliding right towards orange will warm your image,

whereas sliding left will make it more blue, or cool. You want to
slide right, until your shot looks as though it was taken at sunset.

Use colour to change
summer into autumn

file which has been edited by
your camera, so it’s still not
guaranteed to show the
viewer that epic scene you
want to convey.

Take control of colour
We’ve already learned how
powerful Affinity can be, but

TIP
FEELING
BLUE

If you want to make this feel
more wintry, shift your
Colour Balance to blue

instead of warmer
tones.

it’s the small things that can
make the biggest difference.
Everyday tools, such as
Colour Balance and Selective
Colour, can be used to make
subtle tweaks, or even to
completely change the look
and mood of your scene, as
we’ll find out now.

Use HSL to alter the leaves

a Create an HSL Adjustment and change Master to Yellow.
Drag the Hue slider right to 0.8, depending on your

scene, to change the yellow to autumnal browns. Change Yellow
to Green and repeat this to even out the tones.

a Altering the Hue may have changed other areas of your
shot. To undo this, click on the HSL Layer and use a Soft
Edged Paint Brush Tool to brush black over any areas you don’t
want this to be visible, such as the skin or grass.

n Create a Colour Balance Adjustment and drag the Cyan/
Red slider right to introduce a warmer, more autumnal
light. Now drag the Magenta/Green and the Yellow/Blue sliders
left. You should have a warm tint but with natural skin tones.

‘Aannanaan

Apply an autumnal Gradient Map
Create a Gradient Map Adjustment and choose the

green default. Click the middle circle and delete it. Now

click the right most circle and change the colour to green. Set the
Blending mode to Screen and Opacity to 10% and you're done.

PORTRAITS // AFFINITY PHOTO

I KNOWHOW THREE GREAT
WAYS TO CREATE COLOUR

Adjustment Layers are the backbone of any good editing
software, and Affinity Photo has them in spades. These
are three amazing ways to alter your images’ colour.

COLOUR BALANCE
Colour Balance is a much-used tool. It’s
responsible for values of colour in a particular

image, and can be used to subtly grade you work, or even
create a dramatic mood by cooling down the scene, or
using it to mimic soft warm summer light.

HSL
HSL stands for
Hue, Saturation

and Luminance. It allows
you to choose specific
colour channels, and alter
the value of each hue,
meaning you can change
all of your original colours.
You can also control the
saturation and brightness.

SPLIT TONING
Split Toning
assigns different

colour values to the
highlights and shadows.
You can then choose a bias
to decide which colour
dominates. This simple
technique can create a wild
effect, or just introduce
complementary colours into
your work, which really
draws in the viewer’s eye.
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PART 6

SUPERHERO
SHOWDOWN

e

Affinit
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Kirk Schwarz takes you on a journey to create
the next protector of the human species in this
impressive superhero composite tutorial.

OOK, IN THE SKY.
Isitabird? Isita

plane? No, it’s a billboard

for the latest Hollywood
superhero flick. Watching
fully-grown men being flung
through skyscrapers, or
going toe-to-toe against
gigantic aliens is just good
fun, and the inspiration

behind our final Affinity
Photo instalment.
Throughout the guide so
far, you’ve learned how to
edit landscapes with the
Develop and Tone Mapping
Personas, you’ve gone
through complex colour
grading using some of the
best tools on the market, and

“AFFINITY'S SET OF NIFTY
SELECTION TOOLS IS IDEAL TO
CREATE EPIC COMPOSITES”

26 PRACTICAL PHOTOGRAPHY

you’ve mastered the art of
black & white conversions.
One thing we’ve yet to cover,
which Affinity Photo does
incredibly well, is the art of
creating selections. Powerful
features such as the Pen,
Selection Brush and Flood
Select Tools are perfect for
making complex cut-outs -
essential for creating our
composite superhero image.

Where do | start?
The most important shot
you’ll need is the hero, which

T RN e T

-

N 5

&

in this case, is a hero. We’ve
posed him in a dynamic way
and we can still cut him out
precisely. You’ll also need a
gritty background, such as
this city shot we’re using.
Lastly, we’ve added some
fiery wings for that extra
final wow factor.

With all of your individual
components shot or sourced,
it’s just a case of jumping
into Affinity to cut them out
and put them all together to
create your epic cinematic
masterpiece.

BACKGROUND

SELECTING IMAGES ALWAYS

THINK OF THE BIGGER PICTURE

Find your background first, then create
the scene around this. We had a gritty
background, which would allow us to
compose our flying effect. We shot the
model in a dynamic hovering pose and
thought the addition of flames as wings
would help to sell the whole effect.

FLAMES

d3H1VHd H9IFT

II'AFFINITY PHOTO

WHY AFFINITY IS
PERFECT FOR
COMPOSITES

Affinity Photo boasts powerful
features, such as selection tools,
Layers and Masks, all of which are
essential for digital mash-ups.

MAKE YOUR
f‘ SELECTION
™" Affinity offers a handful

of tools which allow you to create
selections, ranging from quick
and easy, to extremely precise
and complex. This is a key area
when it comes to creating
intricate composites.

THE MIGHTY PEN
"‘ The Pen Tool allows
A :
for the most precise
selections, letting you fine-tune
the direction of travel, as well as
create pixel-perfect curves and
spot-on cut-outs.

LAYER MASKS
f‘ % Layer Masks allow you to
" hide an individual Layer’s

effects from the rest of the image,
while retaining the information
should you change your mind at
a later date — an essential for
complex composites.

LEARN TO REFINE
f‘ % Refine allows you to alter
= your selections after

the fact, going as far as offering
a Matte Brush, which makes
Affinity do the hard work on tough
selections, such as flyaway hair.
This makes the whole selection
process incredibly powerful and
very professional.
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Make your selections wisely

HE KEY TO ANY
photo composite

is being able to have your
individual elements interact
seamlessly. This means being
able to have hard edges, or
even soft edges, appear as
they should. It’s also essential
that you don’t include the
background when you’re
cutting out a model, or
accidentally cut off parts of
them. Thankfully, Affinity
has three great tools for this.
You’ll be able to take
advantage of the Selection

Brush or Flood Select Tools,
both of which offer a simple
one-click approach, and

both of which do an excellent
job. You also have the Pen
Tool, which allows you the
ultimate freedom and control.
Simply clicking from one
point to another will create a
line. You can then add natural
curves to these lines, as well
as move them or change the
effect at any point, all of
which make those precise
selections very easy to master
- ideal for our superhero shot.

Open your background shot
To give yourself bearings, open the background shot
first, by clicking File>Open. Once imported, you have

a reference point to work with. Next, select your superhero model
shot and import it by going to File>Place.

Above The powerful selection tools in Affinity make cutting out
your characters simple, while also giving you ultimate control.

Cut out your superhero
You now need to remove your hero from the background.
If the background is pure white, you can use the Flood

Select or Selection Brush Tools. However, if you have a busy
background like ours, select the Pen Tool for precision.

Trace the outline with the Pen Tool
Zoom in and click on the edge of your model, where you
intend to start the selection. Now click a little further up.

You should see a straight line appear, which isn’t good for cutting
out rounded shapes, so we need to learn how to create a curve...

Create natural curved selections
Click once more but don’t let go. Drag the mouse in any
direction. You'll see a line come out of the central anchor

point, which will create a curve in the Pen Tool’s line. Drag until
this fits the outline of your model but don’t let go.

Tell the Pen Tool where to go next
Still holding down your mouse button, hold down the
Alt key and drag the mouse to move the line that was

responsible for the curve. Point it in the direction of your next
point and the transition will be much more natural.

COMPOSITES // AFFINITY PHOTO

\

Turn your outline into a selection
Once finished, head to the toolbar at the top and press
Selection to create a path of marching ants. Now hit

Ctrl+J to duplicate this Layer and delete the original. Use the
Move Tool to resize and place your model.

Create a realistic shadow Place the shadow and add some blur
7 Duplicate your model Layer and open a Levels Move the shadow to the street below and grab the top
Adjustment. Set Black Level to 100%, right-click the of the movement box. Drag this down to squash the

Layer and select Mask to Below. Now right-click on the model shadow Layer. Click Live Filters and choose Gaussian Blur. Move
and choose Transform>Flip Vertical. the slider right until the shadow’s edges are more natural.

LEARN TO USE THE BEST TOOL FOR THE JOB

THE PEN TOOL

!“i‘ With a single click, you can !“i‘ The most powerful and

SELECTION BRUSH TOOL
!‘E' This tool allows you to paint
your selection in, making it
ideal for large areas with high contrast
or strong geometric shapes.

FLOOD SELECT TOOL

select an entire tone or =
colour. You can even change the
Tolerance, giving you a lot of control.

precise tool, this allows you
unlimited freedom to make curved and
pixel-perfect selections.
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Blend images to
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create a story

u FLOATING MAN
may be pretty

impressive in real life, but it
takes quite a bit more than
basic levitation to pass for a
superhero these days. With
this in mind, we’re going to
add some fiery wings to make
our model really look the
part. Although it may sound
extremely difficult to achieve,
it’s a very simple effect, and

can be accomplished with a
stock photo and the Screen
Blending mode. While you
may not have a lot of images
of fireballs at your disposal,
you can easily shoot fireworks
or sparklers against a dark
sky to get the same effect,
then you can use this simple
technique to give your hero
some fiery abilities of their

very own.

Import your ‘special effects’ shot
We have this shot of three fireballs, which we’re bringing

into the document by clicking File>Place. Once in,

duplicate the Layer and hide the original by de-clicking the tick
to the right of its Layer. We will need this Layer later on.

™ | Stock 9972611 (Fixel)

™ | Stock 9972611 (Fixcy

Make the effect even brighter

a The Screen Blending Mode can cause transparency. To
get around this, duplicate your Layer for a better effect.

Once you're happy, hold Ctrl and click every fire Layer to select
them. Press Ctrl+G to put them all into a single group.

TIP
TAKE STOCK

Stock sites can get
expensive, but there are
100% free alternatives such
as unsplash.com where

you can find
useful images.

Background

Above The ability to use multiple Layers and Masks is a must
for anybody who is creating composite images.

M

Lacper 1 (1

Add your fiery wings
Use the Eraser Tool ‘E’ to delete all but one fireball. Once

you have your single flame, use the Move Tool to put it
into place, and change the Blending Mode to Screen, which will
hide any black in the image making it invisible.

Mask out the front of the flames
Create a Layer mask for the new Group. Choose the
Paint Brush Tool ‘B’ and set hardness to 50%. Select

black as the foreground colour and brush where you don’t want
the flames visible, which is the chest and arms.

Repeat for the
other wing
Take the flame Layer we

hid earlier and make it visible. Now
repeat the process, but when you’re using the Move Tool to place
it, right-click and choose Transform>Flip Horizontal. Now put it in
place and mask it out, as per the previous step.

Add some movement to your model
7 Click back to your model Layer and create a Live Filter
Motion Blur. Set the rotation to 90% (or to suit your

pose) and Radius to 30px, which should create a sense of motion.
Unfortunately, it’s blurred the whole model Layer...

Add your final adjustments
Click on your top Layer and create a Curves Adjustment.
Add an ‘S’ curve, which looks like the example above,

to add additional contrast. You can now also add any additional
adjustments that you may have learned from previous tutorials.

COMPOSITES // AFFINITY PHOTO

Paint in the flames’ reflection

a Flames will create a colour cast, so we need to add that.
Create a new Pixel Layer and use the Paint Brush Tool.

Set Flow to 10% and the Foreground Colour to Orange. Paint

where the light should fall and set the Blending Mode to Soft Light.

Mask off the Motion Blur effect
Click on the Motion Blur Layer, which includes its own

Layer Mask. Now use a black Paint Brush Tool to brush

out the blur effect over the model’s face and torso. You can
always paint it back in by switching from black to white.

ALL YOU NEED
TO KNOW

Affinity Photo is yours

for the one-off cost of

£48.99, or only £19.99

for the iPad app. It’s

available on both

Windows and Mac

operating systems. To find

out more about the desktop and iPad versions of Affinity
Photo, visit affinity.serif.com/photo where you’ll also find a
selection of video tutorials helping you get the best out of
the editing software to make the most of your images. ke
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AFFINITY PHOTO

The fastest, smoothest, most powerful professional
photo editor for macOs, Windows and iPad

Affinity Photo redefines the boundaries for professional photo editing software. With
a meticulous focus on workflow it offers sophisticated tools for enhancing, editing and

retouching your images in an incredibly intuitive interface with all the power and

performance you need.

Experience the new way to edit photos with a




